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Overview
File Shredder 2000 is a small utility that will completely erase the contents of sensitive files and entire folders that you specify. 
Normal file deletion only removes a file’s directory entry, but leaves the data contained in the file on your disk drive. File 
Shredder completely overwrites the contents of a file and then deletes it.

File Shredder 2000 is fully Y2K compliant and will work with MS Windows XP and Millenium Edition, Windows 2000 as well as 
9x/NT systems.

To shred files and folders simply drag them to the File Shredder icon in the same way you would the Recycle Bin.

You can also shred files and folders by right-clicking on them from the MS Windows Explorer and selecting the Send To item on 
the popup context menu.

File Shredder has two file wiping methods available, a standard two-pass file clearing procedure and an NSA approved seven-
pass file erasure method. For normal file deletion operations the two-pass method should be sufficient, but if you want to 
thoroughly erase a file’s contents before deleting it the NSA approved method may be used.

Note Files and folders selected for shredding can not be recovered using an undelete program. The purpose of File Shredder is 
to completely remove sensitive files and their contents from you disk drive. Once a file has been shredded it can not be 
recovered using sophisticated file restoration utilities.

Purchasing File Shredder
File Shredder 2000 is a fully functioning program. It is not crippled in any way.

File Shredder 2000 is distributed as shareware. You may evaluate it free of charge for 30 days. After 30 days you are required to
register it. If after evaluating File Shredder for 30 days you decide not to register it you are required to remove it from your 
computer.

You may also purchase File Shredder 2000 using your credit card via the Internet or by telephone.

Registration entitles you to unlimited free updates and support via E-Mail or telephone.



Installing File Shredder
Installation
To install File Shredder 2000 on your computer simply create a new, empty folder and place the files; SHREDDER.EXE, 
SHREDDER.HLP and SHREDDER.CNT there.

SHREDDER.EXE The File Shredder Application
SHREDDER.HLP The Windows Help File
SHREDDER.CNT The Help Contents File

If you installed File Shredder 2000 using the SETUP.EXE program and selected the default installation setting File Shredder 
2000 will be installed in the C:\Program Files\Software by Design folder.

Note If you have an earlier version of File Shredder 2000 installed on your computer, simply replace the SHREDDER.EXE, 
SHREDDER.HLP and SHREDDER.CNT files with the newer versions.

The various application settings specified in the File Shredder Options property sheet as well as the main window’s size and 
location on the desktop are stored in the MS Windows 95/NT System Registry.

Warning If you rename the SHREDDER.EXE file you must also rename the SHREDDER.HLP file using the same basename. 
For example if you change the File Shredder application file name to NewName.exe, rename the help file to NewName.hlp. Do 
not rename the SHREDDER.CNT file however. The HLP and CNT files must reside in the same folder as the File Shredder 
application file itself.

The MS Windows 95/NT Help program creates a pair of files associated with the SHREDDER.HLP file. These files will have file 
extensions of GID and FTS. These files are used to store specific information about the help window location on the desktop and
the word list used for topic searching. These two files will be created when the File Shredder 2000 Help file is first used.



Configuring File Shredder
File Shredder Options
The File Shredder window will be displayed whenever you double-click your mouse on the File Shredder Icon. This window will 
allow you to change the various File Shredder program settings listed below.

Show File Shredder Icon on the Desktop
Check this item to display the File Shredder icon on the desktop. Files can be shredded by simply dragging them on top of the
File Shredder icon. This is similar to deleting files by dragging them to the Recycle Bin.

Add File Shredder to the Send To Menu
Check this item to include File Shredder on the Send To menu. Files can be shredded by simply right-clicking on them in the 
MS Windows Explorer and selecting Send To from the popup context menu.

Go To Shredder Tab When Opening
Check this item to display the Shredder tab immediately when opening the program.

Use NSA File Erasure Algorithm
Check this item to shred files using an NSA approved file erasure algorithm. Files shredded using this method will be 
completely removed from your disk drive using a seven pass file wiping procedure. NSA erasures take longer to perform 
because of the additional disk writing activity required. If this item is not checked files will be shredded using a normal two 
pass file wiping procedure.

Display File Shredder Progress
Check this item to display a small File Shredder progress window while files are being cleared.

Retain Window Sizes and Locations
Check this item to save the size and desktop locations of all File Shredder 2000 program windows, property sheets and dialog
boxes.

Confirm All File Shredder Requests
Check this item to display a File Shredder confirmation dialog before deleting specified files. If this item is not checked File 
Shredder will remove files without first asking for confirmation.

Log All Operations to a Disk File
Check this item to create a log file of all File Shredder operations. A log file named SHREDDER.LOG will be created in the 
same folder that the File Shredder program is located in when this item is checked. This log file is a simple ASCII text file and 
can be opened with any text editor or viewer you choose.

Warning Sounds with Dialog Boxes
Check this box to play a short beep sound when File Shredder displays a warning dialog box or an error occurs.

OK
Press this button when you have completed your selection of File Shredder program options. When you press this button the 
File Shredder Options property sheet will be closed and your settings will be saved.

Cancel
Press this button to close the File Shredder Options property sheet without making any changes. If you have made any 
changes to the option settings and then press this button your changes will not be used, and your previous settings will 
remain in use.

Help
Press this button to open the File Shredder Help Window and go directly to the Configuring File Shredder topic.

Note The options you have selected will be saved when you press the OK button. The desktop location of the File Shredder 
Options window itself will also be stored. Your settings will be saved in the MS Windows 95/NT System Registry.



File Shredder Drag & Drop
File Shredder Drag & Drop
The File Shredder window will be displayed whenever you double-click your mouse on the File Shredder Icon. Select the 
Shredder tab to display a window containing a list containing files to be shredded.

This window will allow you to drag files and folders directly from the MS Explorer. The files and folders dropped in this window 
can later be shredded by using the Shred All Files Listed command described below.

Remove File From List
Press this button to remove the currently selected file from the shredder list.

Note This command removes the selected file from the list, but does not delete the file on the drive.

Shred All Files Listed
Press this button to begin shredding all of the files currently listed.



File Shredder Confirmation
File Shredder Confirmation
The File Shredder confirmation dialog will be displayed before files and documents are shredded if the Confirm All File 
Shredder Requests option was specified.

Yes
Press this button to shred the currently specified file or document.

Yes to All
Press this button to shred the currently specified file or document and all other selected files without displaying the 
confirmation dialog again.

No
Press this button to skip the shredding of the currently specified file or document.

Cancel
Press this button to cancel the entire File Shredder request.



Shredding Read-Only Files
Shredding Read-Only Files
The File Shredder confirmation dialog will be displayed before write protected read-only files and documents are shredded if the 
Confirm All File Shredder Requests option was specified.

Yes
Press this button to unlock and shred the currently specified file or document.

Yes to All
Press this button to unlock and shred the currently specified file or document and all other selected read-only files without 
displaying the confirmation dialog again.

No
Press this button to skip the shredding of the currently specified read-only file or document.

Cancel
Press this button to cancel the entire File Shredder request.



File Shredder Progress
File Shredder Progress
The File Shredder progress window will be displayed while files and documents are being shredded if the Display File 
Shredder Progress option was specified.



Troubleshooting FAQs
Troubleshooting FAQs
This is a compilation of the most frequently asked questions I receive regarding File Shredder 2000.

Will File Shredder work with MS Windows ME/XP?
Yes File Shredder will work with MS Windows ME and XP as well as 95/NT systems.

Will File Shredder work with MS Windows 98?
Yes File Shredder will work with MS Windows 98 as well as 95/NT systems.

Will File Shredder work with MS Windows 2000?
Yes, File Shredder will work with MS Windows 2000 as well as 9x/NT systems.

Is File Shredder Year 2000 Compliant?
Yes, File Shredder 2000 is fully Y2K compliant.

File Shredder windows and dialog boxes move!
Some versions of MS Windows incorrectly report desktop window locations. If the main File Shredder window location 
changes position each time it is launched, or the various tabs on the File Shredder property sheets cause the window to move
during use turn off the Retain Windows Sizes and Locations option setting.



Comments and Upgrades
Comments and Suggestions
If you have comments, questions or find any bugs in File Shredder 2000 please feel free to contact me on CompuServe.

Gregory Braun – Software Design

Email: Support@GregoryBraun.com
Web Site: http://www.gregorybraun.com
Phone: 1.414.817.6508

Web Site
Visit my web site on the Internet to download the latest versions of all of my software offerings.

Software Design Web Site

(http://www.gregorybraun.com)



Release History
File Shredder 2000 Release History

v2.0 Original in-house development and testing of MS Windows 95/NT conversion using the Microsoft Win32 SDK.

v2.1 Added 95/NT splash box for release.

v2.2 Added MS Windows 95/NT Help file. 

v2.3 Shredded file sizes are now set to zero bytes and file timestamps are reset to 1-Jan-1980 before being removed. Added 
time of shredding to the log file. Fixed several other minor bugs.

v2.4 Adds a facility to shred entire folders dropped on the File Shredder desktop icon. Fixed several other minor bugs.

v2.5 Adds a facility to optionally shred write protected read-only files and documents. Fixed several other minor bugs.

v2.6 Fixed several minor bugs.

v2.7 Fixed a bug that prevented moving off of the Registration property sheet page if user and organization information was 
not found.

v2.8 Added a new file shredding window. Fixed several minor bugs.

v2.9 Added new window options. Fixed several minor bugs.

v3.0 Added support for MS Windows Millenium Edition and Windows 2000. Fixed several minor bugs.

v3.1 Fixed a bug that prevented some file names with spaces in their names from being properly detected.

v3.2 Adds support for MS Windows XP Systems. Fixed several minor bugs.

v3.3 Fixed several minor bugs. This is a maintanance release.

Last Update  April    8th, 2002

Web Site
Visit my web site on the Internet to download the latest versions of all of my software offerings.

Software Design Web Site

(http://www.gregorybraun.com)



System Registry
File Shredder 2000 System Registry Key
File Shredder 2000 stores configuration settings in the MS Windows 95/NT System Registry. These settings are updated 
automatically while File Shredder is running. There is no need to edit these settings manually.

If you insist upon editing these settings, you do so at your own risk. File Shredder automatically updates registry entries when it 
exits. If you edit these settings make sure File Shredder is not running while you edit them. If File Shredder is currently running 
your changes will be overwritten when File Shredder exits.

File Shredder 2000 stores configuration settings in the following system registry key:

HKEY_CURRENT_USER
Software

Software by Design
File Shredder for Windows 95/NT

Section
Label = Value

Warning There is no need to edit these settings manually. File Shredder will automatically maintain these settings for you. If you 
do edit these, you do so at your own risk.



Removing File Shredder
Removing File Shredder 2000
If you find that File Shredder 2000 does not meet your needs you can remove it from your computer system by simply deleting 
the following files from your hard drive.

All of these files will be located in the folder that you originally installed File Shredder in.

The default location for all File Shredder 2000 program files is the C:\Program Files\Software by Design folder. Unless you 
specified a different folder when you ran SETUP.EXE you will find the File Shredder files here.

Shredder.exe File Shredder application program.
Shredder.cnt File Shredder Help Topics File
Shredder.hlp File Shredder Help File

If you have opened and used the File Shredder 2000 Help files your system may contain the following two (2) files. These files 
are created by the standard MS Windows 95/NT Help program WinHlp32.exe. These files may also be safely removed.

Shredder.gid MS Windows Help settings file. This file contains the File Shredder Help window size and desktop 
location as well as any bookmarks you may have created.

Shredder.fts MS Windows Help word database. This file is created when you build a custom word list for File 
Shredder Help files. This file is used to search for words and phrases in the File Shredder Help files.

File Shredder 2000 does not use any custom DLL files or system drivers. If you delete the files mentioned above from your 
system’s hard drive you will have completely removed File Shredder from your computer system.



Software Design Web Site
Software Design
You can download the latest versions of all of my software from my web site on the Internet. I post the latest releases of my 
software there first. Click your mouse on the link listed below to visit the Software Design web site.

Software Design Web Site

(http://www.gregorybraun.com)

Software Titles
The following software titles are available at my web site on the Internet and can also be found on CompuServe, ExecPC, MSN 
and ZD Net.

AppPaths 2000 (APPPATHS.ZIP)
Audition 2000 (AUDITION.ZIP)
BattleStar 2000 (BSTAR32.ZIP)
BattleStar for Windows (BSTAR.ZIP)
BlowFish 2000 (BLOWFISH.ZIP)
Calendar 2000 (CALENDAR.ZIP)
CardBase 2000 (CARDBASE.ZIP)
Crypto 2000 (CRYPTO.ZIP)
Disk CleanUp 2000 (CLEANUP.ZIP)
DLL Show for Windows 9x/ME (DLLSHOW.ZIP)
File Editor 2000 (FXEDIT32.ZIP)
File Editor for Windows (FXEDIT.ZIP)
File Shredder 2000 (SHREDDER.ZIP)
FontShow 2000 (FONTSHOW.ZIP)
Icon Extractor 2000 (ICONX32.ZIP)
Icon Extractor for Windows (ICONX.ZIP)
Kart Data 2000 (KARTDATA.ZIP)
Lap Timer 2000 (LAPTIMER.ZIP)
MS Windows Error Messages (MSWINERR.ZIP)
NoteBook 2000 (NBOOK32.ZIP)
NoteBook for Windows (NBOOK.ZIP)
Password Keeper (PASSKEEP.ZIP)
Phantom Desktop Screen Saver (PHANTOM.ZIP)
Programmer's IDE 2000 (PMAN32.ZIP)
Programmer's IDE (PMAN.ZIP)
Reminders 2000 (REMIND32.ZIP)
Reminders for Windows (REMIND.ZIP)
RGB Editor 2000 (RGB32.ZIP)
RGB Editor for Windows (RGB.ZIP)
Screen Loupe for Macintosh (LOUPE.SEA)
Screen Loupe 2000 (LOUPE32.ZIP)
Screen Loupe for Windows (LOUPE.ZIP)
Slot Cars 2000 (SLOTCARS.ZIP)
Stay Live 2000 (STAYLIVE.ZIP)
Submit It 2000 (SUBMITIT.ZIP)
ToolBar 2000 (TBAR32.ZIP)
ToolBar for Windows (TBAR.ZIP)
Touch for Windows (WTOUCH.ZIP)
TxEdit 2000 (TXEDIT.ZIP)
Unit Conversions 2000 (UCONVERT.ZIP)
WebTime 2000 (WEBTIME.ZIP)
World Radio for Macintosh (WRADIO.SEA)

Note The latest versions of my software programs are always posted on my web site first. Versions found on the other online 
services may be earlier releases.



BBS and Internet Operators
Webmasters
Please upload the original ZIP file intact and title the submission:

"File Shredder 2000 v3.3"
--Author Gregory Braun

Web Site
Visit my web site on the Internet to download the latest versions of all of my software offerings.

Software Design Web Site

(http://www.gregorybraun.com)

Note This site also supports anonymous FTP transfers.



What is Shareware
The concept of "Shareware"...
Shareware, also known as user supported software and other names, is a concept not understood by everyone. The author of 
Shareware retains all rights to the software under the copyright laws while still allowing free distribution. This gives the user the 
chance to freely obtain and try out software to see if it fits their needs. Shareware should not be confused with Public Domain 
software even though they are often obtained from the same sources.

If you continue to use Shareware after trying it out, you are expected to register your use with the author and pay a registration 
fee. What you get in return depends on the author, but may include a printed manual, free updates, telephone support, etc. Only 
by paying for the Shareware you use do you enable the Shareware author to continue to support his software and create new 
programs. Considering that the Shareware registration fees are almost always far less than the purchase price of comparable 
commercial software it's obvious that Shareware is a good deal for everyone.

There are real advantages to you in the Shareware system. You get to try out software to make sure it is compatible with your 
hardware and that it fits your needs before you "buy" it with your registration. The author saves the expense of advertising, 
packaging and distribution and passes the savings on to you. Plus, most Shareware authors are much more accessible than 
commercial software sources so that your questions and suggestions are much more likely to be responded to.

Thank you for your support.



Registering File Shredder 2000
Registering File Shredder
File Shredder 2000 is distributed as shareware. You may evaluate it free of charge for 30 days. After 30 days you are required to
register it. If after evaluating File Shredder for 30 days you decide not to register it you are required to remove it from your 
computer.

Registration entitles you to unlimited free updates and telephone support.

You can register File Shredder 2000 by mailing the Order Form provided with this software. When you register File Shredder 
2000 you will receive your registration code by E-Mail, or optionally you may request that your registration code be mailed to 
you.

You may also purchase File Shredder 2000 using your credit card via the Internet or by telephone.

The software you are currently using is a fully functioning program. As a registered user you will be able to disable the initial 
splash box that appears when File Shredder 2000 is first launched.

User Name
Enter the user name you originally specified when you ordered File Shredder 2000.

Organization
Enter the name of your organization as originally specified when you ordered File Shredder 2000. If you did not specify an 
organization name leave this field blank.

Registration
Enter the registration code that was provided to you. Enter your registration code exactly as provided. Do not include spaces 
when entering your registration code.

Note The registration code was provided to you when you purchased File Shredder 2000. Refer to the notification letter that 
was mailed to you or the E-Mail message you received for your personal shareware registration code.

Show Splash Box at Startup
This box will be initially checked if you have not registered File Shredder 2000. When you successfully register your copy of 
File Shredder this box will automatically be unchecked for you. If you wish to see the splash box when File Shredder is 
launched return to this Registration Wizard and check this box.

OK
Press this button after you have filled out the Shareware Registration Wizard to complete File Shredder 2000 shareware 
registration.

Cancel
Press this button to close the Shareware Registration Wizard    without making any changes.

Help
Press this button to open the File Shredder Help window and go directly to the Registering File Shredder topic.



Purchasing Information
Purchasing Information
File Shredder 2000 is distributed as shareware. You may evaluate it free of charge for 30 days. After 30 days you are required to
register it. If after evaluating File Shredder for 30 days you decide not to purchase it you are required to remove it from your 
computer.

Registration entitles you to unlimited free updates and telephone support.

You can register File Shredder 2000 by mailing the Order Form provided with this software. When you register File Shredder 
2000 you will receive your registration code by E-Mail, or optionally you may request that your registration code be mailed to 
you.

You may also purchase File Shredder 2000 using your credit card via the Internet or by telephone.

The software you are currently using is a fully functioning program. As a registered user you will however be able to disable the 
initial splash box that appears when File Shredder 2000 is first launched.

Single User Licensing
Individual users can register File Shredder 2000 for $25.00 dollars. If you would also like a 3 ½” floppy disk sent to you please 
add an additional $5.00 dollars. Registration entitles you to unlimited free updates and telephone support. You can always 
download the latest release of File Shredder directly from the Software Design web site on the Internet. Print the File Shredder 
2000 Order Form and mail it with your check to become a registered user of File Shredder 2000.

Site Licensing
File Shredder 2000 can also be registered for use at an entire site for $250.00 dollars. If you would like to install and use File 
Shredder on multiple workstations at a single location choose this type of licensing. Registration includes a 3 ½” floppy disk and 
entitles you to unlimited free updates and telephone support. You can always download the latest release of File Shredder 
directly from the Software Design web site on the Internet. Print the File Shredder 2000 Order Form and mail it with your check 
to become a registered user of File Shredder 2000.

Corporate Licensing
File Shredder 2000 can also be registered for use at multiple sites for $1000.00 dollars. If you would like to install and use File 
Shredder on multiple workstations at multiple locations choose this type of licensing. Registration includes a 3 ½” floppy disk 
and entitles you to unlimited free updates and telephone support. You can always download the latest release of File Shredder 
directly from the Software Design web site on the Internet. Print the File Shredder 2000 Order Form and mail it with your check 
to become a registered user of File Shredder 2000.



File Shredder 2000 Order Form
To print this order form, press the Print button above, or select Print Topic from the File pull-down menu.

Secure on-line credit card orders can be placed from the Software Design web site.

To order by check, send this order form and a check to:

Gregory Braun
P.O. Box 1307
Milwaukee, WI    53201-1307 U.S.A.

Payments must be in US dollars drawn on a US bank, or you can send international postal orders in US dollars.

All orders are subject to the License Agreement.

Customer information is considered confidential and will not be shared or distributed to any third parties.

Registered users of File Shredder 2000 are entitled to unlimited free program updates.

Single User Copy ______ at $25.00 each = ________

Optional 3 ½” Disk ______ at $5.00 each = ________
Site License ______ at $250.00 each = ________

Includes 3 ½” Disk
Corporate License ______ at $1000.00 each = ________

Includes 3 ½” Disk

Wisconsin Residents add 5.5% sales tax: ________

Total Payment: ________

Date ____________________________________

Name ____________________________________

Organization ____________________________________

Shipping Address ____________________________________

____________________________________

City ____________________________________

State ____________________________________

Zip Code ____________________________________

Country ____________________________________

Day Phone ____________________________________

E-Mail Address ____________________________________
[    ] Please send registration code via E-Mail

Comments:





Credit Card Purchases
Credit Card Purchases
You may purchase File Shredder 2000 by credit card over the telephone or directly from my web site on the Internet.

On-line Registration
Secure on-line registration using a major credit card is available directly from the Software Design web site. Simply go to the File
Shredder 2000 program description page and click your mouse on the RegNet link. You may register File Shredder 2000 using 
your Master Card, Visa, American Express, Discover or EuroCard. Registration keys will be sent to you via eMail.

Telephone Registration
You may also purchase File Shredder 2000 toll-free by telephone. Please specify File Shredder 2000 when ordering.

Toll-Free: 1.800.999.2734
International: 1.719.576.0123
FAX Line: 1.719.623.0399

RegNet Product Codes
2353 File Shredder Single User License
4310 File Shredder Site License
4309 File Shredder Corporate License

RegNet Pages
Single User http://www.reg.net/product.asp?ID=2353
Site License http://www.reg.net/product.asp?ID=4310
Corporate http://www.reg.net/product.asp?ID=4309

Web Site
Click your mouse on the underlined link below to purchase File Shredder 2000 by credit card.

Software Design Web Site

(http://www.gregorybraun.com)



License Agreement
License Agreement

You should carefully read the following terms and conditions before using this software.    Unless you have a different license 
agreement signed by Gregory Braun, your use of this software indicates your acceptance of this license agreement and 
warranty.

Registered Version
One registered copy of File Shredder 2000 may either be used by a single person who uses the software personally on one or
more computers, or installed on a single workstation used nonsimultaneously by multiple people, but not both.

Site License
Any number of users at a single location may access the registered version of File Shredder 2000 through a network, 
provided that you have obtained a site license for the software covering all workstations that will access the software through 
the network. Any number of users at a single location can install and use the software on one or more computers or 
workstations.

Corporate License
Any number of users at any number of locations may access the registered version of File Shredder 2000 through a network, 
provided that you have obtained a corporate license for the software covering all workstations that will access the software 
through the network. Any number of users at any number of locations can install and use the software on one or more 
computers or workstations.

Software Updates
Registered users of File Shredder 2000 are entitled to unlimited free program updates. Software updates can be downloaded 
directly from the Software Design web site on the Internet. Registered users are also entitled to free E-Mail and telephone 
support.

Governing Law
This agreement shall be governed by the laws of the State of Wisconsin.

Disclaimer of Warranty
THIS SOFTWARE AND THE ACCOMPANYING FILES ARE SOLD "AS IS" AND WITHOUT WARRANTIES AS TO 
PERFORMANCE OR MERCHANTABILITY OR ANY OTHER WARRANTIES WHETHER EXPRESSED OR IMPLIED. NO 
WARRANTY OF FITNESS FOR A PARTICULAR PURPOSE IS OFFERED.

Good data processing procedure dictates that any program be thoroughly tested with non-critical data before relying on it. The user
must assume the entire risk of using the program.    ANY LIABILITY OF THE SELLER WILL BE LIMITED EXCLUSIVELY TO 
PRODUCT REPLACEMENT OR REFUND OF PURCHASE PRICE.



Using the Help File
Using the Help File
The settings and commands described in this section apply to the File Shredder 2000 Help window, not the File Shredder 2000 
program itself.

Context Sensitive Help
Most File Shredder 2000 windows, property sheets and dialog boxes provide a Help button in the lower right-hand corner of the 
window. Pressing the Help button in any of these windows will open the File Shredder 2000 Help File and take you directly to 
that section of the Help File pertaining to the window currently in use.

Navigating the Help File
MS Windows Help Files include hyperlinks similar to those used by most Internet Web Browsers. Clicking your mouse on an 
underlined word or phrase will take you directly to that section of the Help File. Pressing the Back button at the top of the Help 
window will return you to the page you were previously viewing.

Browsing the Help File
You can also browse through all of the sections in the Help File by pressing the [ << ] and [ >> ] buttons displayed at the top of 
the Help window.

Printing the Help File
You can print individual pages of the Help file by pressing the Print button at the top of the Help window. Unfortunately Help 
topics must be printed one at a time. The MS Windows Help system does not provide a single command to print the entire Help 
file.

Searching the Help File
You may search the entire Help file for a specific word or phrase by pressing the Find button at the top of the Help window. The 
first time the Find tab is selected you will be prompted to build an index or words contained in the Help file. The Find command 
opens a second window with three tabs. Select the Find tab to search for a word or phrase. The Index tab can also be selected 
to search for commonly used topics and subjects.

Table of Contents
You can also view the entire Table of Contents for the Help file by pressing the Help Topics button at the top of the Help 
window. The Contents tab of the Help Topics window provides an easy means of viewing the entire Table of Contents arranged 
by section and topic.

Bookmarks
You can also create your own set of bookmarks for pages of the Help file that you refer to often. Use the Bookmark | Define 
menu command to add a new bookmark to the section of the Help file you are currently viewing or select a previously defined 
bookmark from the list to go directly to that section of the Help file.

Annotations
You can also create your own set of annotations for pages of the Help file that you refer to often. Use the Edit | Annotate menu 
command to add your own comments and notes about a specific page in the Help File. Annotated Help file pages will include a 
small paperclip graphic in the upper left-hand corner of the current page. Click your mouse on this small paperclip to display any
notes or comments you have recorded.

Customizing Help
The MS Windows Help File system can be customized to better suit your viewing needs and habits. See the Customizing Help 
section for more information about customization.



Customizing Help
Customizing Help
You can customize this help file to better suit your needs and uses. The following topics describe the various settings that can be
configured. The settings you specify will be saved and used again each time you view this help file.

Font Size
The size of the font used in this help file can be made larger or smaller by selecting the Font item from the Options menu 
above. Select Small, Normal or Large fonts from the popup menu. The font size you select will be saved and used again each 
time you view this help file.

Window Size
The size of this Help window and its location on the desktop can be adjusted using the standard Windows resizing and 
placement methods. The window size and its location on the desktop will be saved and used again each time you view this help 
file.

Window Background Color
The background color for this help window can be changed to white if you prefer. To change the background color to white select
the Use System Colors item from the Options menu above. For the color changes to take effect you will have to close and 
then reopen the Help file. You will be prompted to confirm this action. Your background color selection will be saved and used 
again each time you view this help file.

Window Placement
By default this help window positions itself in front of all other open windows. If you would prefer to have it covered up by other 
active windows select the Keep Help on Top item from the Options menu and then select Not on Top from the popup menu. 
Your selection will be saved and used again each time you view this help file.






